LENESANS Release Note

RZ/T2H Group

Encoder I/F A-format sample program

Summary
This document describes the RZ/T2H Encoder I/F A-format® sample program package.

For A-format® Ver.2.0 communication protocol specifications and encoder specifications (RES-61QAP06),
contact Nikon Corporation.

Functionality Checked Device
RZ/T2H Evaluation Board (RTKORZT2HXXXXXXXXX)

Contents

(R o= Tl = To (=Y @0 1 1= | £ 2
R S T 1,77 T S 2
L B Lo o1 U o 11T 0 | T PP UPP P PPTPPPTP 2
2. FlE STUCIUIE ... et e e e e et e e e e e e e e ee e e e 3
3. About A-format Sample Program .............eeeeiiiiii e 5
3.1 Software INFOrmMation ... et e et e e e e e e et e e e e e e e e e e eeeeaaeeaaannes 5
B Py O = = T 1 SRS 5
B 2 |V =T 4o To VS 1 2= S USRS 5
3.2 Hardware INfOIMATIoN ...........eiiiiiieiie ettt e ettt e e e st e e e ennte e e e e nneeeeeenneeeeeennes 6
2 O I T o USSR 6
T - T o = = T Y- o P PPPPPPRPPPPN 6
3.3  Procedures on Development Environments: CR52 Ver. ... 8
3.3.1 Preparation before Executing the Sample Program............cccuviiiiii i 8
3.3.2 EWARM from TAR SYSIEMS ... . ettt enbe e e e 8
3.3.3  e2studio from RENESAS ...ttt e et ae et e st e s nteesnteeareeesnteeenneeennes 10
3.4  Procedures on Development Environments: CASS VEI...........uiiiiiiiiiieee e 12
3.4.1 Preparation before Executing the Sample Program...........cccueiiiiiiiiiiieiee e 12
3.4.2 EWARM from TAR SYSIEMS ... .eeiiiiiiiiie et 12
3.4.3  e2studio from RENESAS ...ttt ste et e e s ste e st e e s nteesnteeanreeesnteeaseeennes 14
REVISION HISTOMY ...ttt nnnnnnnnnne 18

A-format is a registered trademark of Nikon Corporation.

R11AN0779EJ0201 Rev.2.01 Page 1 of 18



RZ/T2H Group Encoder I/F A-format sample program

1. Package Contents

This package contains the following contents.

The RZ/T2H encoder interface supports up to 16 axes, but the sample program uses only 1 axis of them. If
you use with 2 axes or more simultaneously, modify the sample program to support required axes.

This sample program operation was checked with one-to-one connection A-format Ver.2.0 encoder.
Operation with bus connection encoder is not checked. Operation with A-format Ver.1.0 encoder is not

supported.

1.1 Software
e Source code

No. Name Version number
1 RZ/T2H A-format sample program (CR52 ver.*) 2.0
2 RZ/T2H A-format sample program (CA55 ver.*) 20

Note This sample program has a CR52 version that runs on the CPU core Cortex-R52 and a CA55 version
that runs on the CPU core Cortex-A55. CR52 ver. and CA55 ver. are descriptions of the respective
version.

1.2 Documents

No. Document name Version File name

1 RZ/T2H Group Encoder I/F 2.01 () r11an0779jj0201-rzt2h.pdf
A-format sample program (e) r11an0779e€j0201-rzt2h.pdf (this document)
Release Note

2 RZ/T2H Group A-format 2.00 (j) r11an0778j0200-rzt2h-a-format.pdf
sample program Application (e) r11an0778ej0200-rzt2h-a-format.pdf
Note
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RZ/T2H Group Encoder I/F A-format sample program

2. File Structure

The file structure and contents of this package are detailed below.
Top

— r11an0779jj0201-rzt2h.pdf

F— r11an0779ej0201-rzt2h.pdf

L— workspace

— Software
\ — iccarm
\ | —RZ_T2H_CR52_a_as.zip : RZ/T2H A-format sample program set
o CR52 ver. (IAR)
| | —RZ T2H _CA55 a_as.zip
| | F—RZ_T2H CA55 0 _a_as : RZ/T2H A-format sample program set
| | CA55 ver. (IAR)
| | L—RZ_T2H_CR52_0_primary :CPU CTRL register setting program (IAR)
| —gcc
| — RZ_T2H_CR52_a_as.zip : RZ/T2H A-format sample program set
| | CR52 ver. (e? studio)
| L— RZ_T2H_CA55_a_as.zip
| F—RZ_T2H CA55 0 _a_as : RZ/T2H A-format sample program set
| | CAS55 ver. (e? studio)
| L—RZ_T2H_CR52_0 primary :CPU_CTRL register setting program (e2 studio)
— Documents
— r11an0778jj0200-rzt2h-a-format.pdf
L— r11an0778ej0200-rzt2h-a-format.pdf
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RZ/T2H Group Encoder I/F A-format sample program

The file structure of the RZ_T2H_CR52_a_as.zip and RZ_T2H_CA55 0_a_as folder is shown below.

Top folder
— configuration.xml : FSP Configuration data
— ( Build Tool Dependent Environment File )
L—src
— hal_entry.c : A-format sample program
F—a_as_main.c : A-format sample program
— siochar.c : SCI_UART sample program
— siorw.c : SCI_UART sample program
— sio_char.h : SCI_UART sample program
L—drv
L—a as
— iodefine_a_as.h : A_AS register definition file
F—r_a_as rzt2.c : A_AS driver file
F—r_a_as_rzt2_config.h : A_AS driver file
F—r_a_as_rzt2_dat.h : A_AS driver file
F—r_a_as_rzt2_if.h : A_AS driver file
F—r_a_as_rzt2_private.h : A_AS driver file
L— a_format
—r_a_format_rzt2.c : A-format driver file
—r_a_format_rzt2_config.h  : A-format driver file

L—r_a_format_rzt2_private.h : A-format driver file

The file structure of the RZ_T2H_CR52_0_primary is shown below.

Top folder
I configuration.xml : FSP Configuration data
— ( Build Tool Dependent Environment File )
L—src

L— hal_entry.c : CA55 start-up program
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RZ/T2H Group

Encoder I/F A-format sample program

3. About A-format Sample Program

This section contains information necessary to use the complete set of A-format sample program.

3.1 Software Information
3.1.1 Base OS

This sample program is OS-independent.

3.1.2 Memory Size

Memory size used by this sample program and A-format driver is shown in following table. This table does
not include memory size used by Flexible Software Package or C language libraries of the compiler.

(1) CR52 ver.

ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
A-format driver Code 4.2 3.5
Data (with initial value) 0.0 0.0
Data (without initial value) 6.1 6.1
Constant Data 0.2 0.2
Sample program Code 4.2 4.8
Data (with initial value) 0.1 0.0
Data (without initial value) 0.8 0.8
Constant Data 1.8 1.9

(2) CADb55 ver.
ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
A-format driver Code 6.1 59
Data (with initial value) 0.0 0.0
Data (without initial value) 6.7 6.8
Constant Data 0.3 0.3
Sample program Code 6.5 8.5
Data (with initial value) 0.2 0.0
Data (without initial value) 0.8 0.9
Constant Data 1.9 2.1
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RZ/T2H Group

Encoder I/F A-format sample program

3.2 Hardware Information
3.21
RZ/T2H

Device

3.2.2 Target Board
(1) Board Name

RZ/T2H Evaluation Board (RTKORZT2HXXXXXXXXX)

(2) Setting of Target Board
The target board configuration is as follows.
SW1-6: OFF
SW2-1: ON, SW2-2: OFF
SW2-7: OFF
SW2-8: OFF

SW14-1: ON, SW14-2: OFF, SW14-3: ON, SW14-6: OFF (Set xSPI1 boot mode)

CN39: Short between 2-3 pins (Set VDD1833 210 3.3 V)
CN40: Short between 2-3 pins (Set VDD1833_3 to 3.3 V)

CN78: Short between 1-2 pins, Open between 3-4 pins, and between 5-6 pins (Set VDD1833_6 to 3.3 V)

Note: To use Target board RTKORZT2HOCW1000BJ with connecting RS-485 board, power on/off by

plugging and unplugging to the power-supply connector CN47 with keeping the slide switch SW16 on.

(3) Used Pin for Target Board

The correspondence between the pin used as the encoder I/F and the pin header of the target board is as

follows.
Channel Port Name Pin Header | Input/Output Voltage Description
Domain

AFMTO | ENCIFDIOO (SDAT) CN2 #9 Input VDD33 Data input
ENCIFDOO00 (REQ) CN2 #7 Output VDD33 Data output
ENCIFOEOQO (D/R) CN2 #5 Output VDD33 Drive/receive control

AFMT1 | ENCIFDIO1 (SDAT) CN2 #8 Input VDD1833_3 Data input
ENCIFDOO01 (REQ) CN2 #6 Output VDD1833_3 Data output
ENCIFOEO1 (D/R) CN2 #4 Output VDD1833_3 Drive/receive control

AFMT2 | ENCIFDIO2 (SDAT) CN2 #17 Input VDD33 Data input
ENCIFDOO02 (REQ) CN2 #15 Output VDD33 Data output
ENCIFOEO2 (D/R) CN2 #13 Output VDD33 Drive/receive control

AFMT3 | ENCIFDIO3 (SDAT) CN2 #18 Input VDD33 Data input
ENCIFDOO03 (REQ) CN2 #16 Output VDD33 Data output
ENCIFOEOQ3 (D/R) CN2 #14 Output VDD33 Drive/receive control

AFMT4 | ENCIFDIO4 (SDAT) CN2 #27 Input VDD1833_5 Data input
ENCIFDO04 (REQ) CN2 #25 Output VDD1833_5 Data output
ENCIFOEO4 (D/R) CN2 #23 Output VDD33 Drive/receive control

AFMT5 | ENCIFDIO5 (SDAT) CN2 #26 Input VDD1833_6 Data input
ENCIFDOO05 (REQ) CN2 #24 Output VDD1833_6 Data output
ENCIFOEO0S5 (D/R) CN2 #22 Output VDD1833_6 Drive/receive control

AFMT6 | ENCIFDIO6 (SDAT) CN3 #9 Input VDD1833_3 Data input
ENCIFDOO06 (REQ) CN3 #7 Output VDD1833_3 Data output
ENCIFOEO6 (D/R) CN3 #5 Output VDD1833_3 Drive/receive control
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RZ/T2H Group

Encoder I/F A-format sample program

Channel Port Name Pin Header | Input/Output Voltage Description
Domain
AFMT7 | ENCIFDIO7 (SDAT) CN3 #8 Input VDD1833_3 Data input
ENCIFDOO07 (REQ) CN3 #6 Output VDD1833_3 Data output
ENCIFOEQ7 (D/R) CN3 #4 Output VDD1833_3 Drive/receive control
AFMT8 | ENCIFDIO8 (SDAT) CN3 #17 Input VDD33 Data input
ENCIFDOO08 (REQ) CN3 #15 Output VDD33 Data output
ENCIFOEOS8 (D/R) CN3 #13 Output VDD33 Drive/receive control
AFMT9 | ENCIFDIO9 (SDAT) CN3 #18 Input VDD1833_2 Data input
ENCIFDOO09 (REQ) CN3 #16 Output VDD1833_2 Data output
ENCIFOEOQ9 (D/R) CN3 #14 Output VDD1833_2 Drive/receive control
AFMT10 | ENCIFDI10 (SDAT) CN3 #27 Input VDD1833_2 Data input
ENCIFDO10 (REQ) CN3 #25 Output VDD1833_2 Data output
ENCIFOE10 (D/R) CN3 #23 Output VDD1833_2 Drive/receive control
AFMT11 | ENCIFDI11 (SDAT) CN3 #26 Input VDD1833_2 Data input
ENCIFDO11 (REQ) CN3 #24 Output VDD1833_2 Data output
ENCIFOE11 (D/R) CN3 #22 Output VDD1833_2 Drive/receive control
AFMT12 | ENCIFDI12 (SDAT) CN10 #9 Input VDD1833_6 Data input
ENCIFDO12 (REQ) CN10 #7 Output VDD1833_6 Data output
ENCIFOE12 (D/R) CN10 #5 Output VDD1833_6 Drive/receive control
AFMT13 | ENCIFDI13 (SDAT) CN10 #8 Input VDD1833_6 Data input
ENCIFDO13 (REQ) CN10 #6 Output VDD1833_6 Data output
ENCIFOE13 (D/R) CN10#4 Output VDD1833_6 Drive/receive control
AFMT14 | ENCIFDI14 (SDAT) | CN10 #17 Input VDD33 Data input
ENCIFDO14 (REQ) | CN10#15 Output VDD33 Data output
ENCIFOE14 (D/R) CN10 #13 Output VDD33 Drive/receive control
AFMT15 | ENCIFDI15 (SDAT) | CN10 #18 Input VDD33 Data input
ENCIFDO15 (REQ) | CN10 #16 Output VDD33 Data output
ENCIFOE15 (D/R) CN10 #14 Output VDD33 Drive/receive control
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RZ/T2H Group

Encoder I/F A-format sample program

3.3 Procedures on Development Environments: CR52 ver.

3.3.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select higher-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Order of transmission / reception LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.3.2 EWARM from IAR Systems
(1) Build Environment

IAR Embedded Workbench for ARM (EWARM)

Version 9.60.2 + patch (EWARM_Patch_for RZT2H N2H_rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2024-10
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Extract RZ_T2H_CR52_a_as.zip and copy the extracted source files to the desired location.
Activate EWARM.

2
3 Select [File] menu -> [Open Workspace].

4 Open the extracted source file RZ_T2H _a_as.eww.

5 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.
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RZ/T2H Group Encoder I/F A-format sample program

6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

G C:¥1_Prog¥Work¥Work C¥Work EWA 960 2 fsp2.2.0¢RZT2H_Aform release chk - FSP Smart Configurator - [m) X ‘
File Window Run Help
2H_Aform_release_chk] FSP Configuration %% FSP Visualization = a
Summary Generate Project Content [| 6%
Project Summary
RENESAS
Board: RZT2H Evaluation Board (RAM execution without flash memory) -
Device: ROAD9GO7TM44GBG
Core: CR52 CPUO >
FSP Version: 220
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_EWA_960_2_fsp2 2. 0/RZT2H_Aform_release_chk
Selected software components
Board support package for ROA0OGOT7MA4GBG V220
Board support package for RZT2H V220
Board support package for RZT2H - FSP Data V220 b
=
4 § =0 B console o ot )
Value No consoles to display at this time
< >

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_T2H_a_as.out is generated.

(4) Sample Program Execution Procedure

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/T2H Group A-format Sample Program Application Note.

1 COM10 - Tera Term VT - O X

774 A (5 JURO-INO) HuESW) ALTH)
rt -~

RE(E
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RZ/T2H Group Encoder I/F A-format sample program

3.3.3 e? studio from RENESAS
(1) Build Environment

RENESAS e? studio 2024-10
Toolchain version: GNU ARM Embedded 12.2.1.arm-12-24
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
SEGGER J-Link v7.98¢c

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_T2H CR52_a_as.zip and copy the extracted source files to the desired location.

2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select
Existing project to workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].

5 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

aRZTZHiAfDrmJeleasE;hk-e:studio — O o ‘
File Edit Source Refactor MNavigate Search Project Renesas Views Run Renesas Al Window Help

B4~ Wit Q- Q i®||Edes
{1 Project Explorer = e = 0 ||B= outline X = 0|z

=k § There is no active editor
v &5 RZ_T2H_a_as that provides an outline.

i Includes

¢ configurationxml

RZ_T2H_a_as Debug_Flat,link
X| RZ_T2H_a_as Debug_Flat.laur
7) Developer Assistance

2. problems x | B Console| [C] Properties @ Smart Browser L} Smart Manual ¢ = 0
0 errors, 12 wamings, 0 others
Description Resource Path Location Type

5 Wamnings (12 items)
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6 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rzt, rzt_cfg, rzt_gen, script, .settings folders are generated.

) RZT2H_Aform _release_chk - RZ_T2H_a_as/confiqurationxml - ¢ studio

- o x
File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas Al Window Help
') 4 e Q
R o it Qv

B cuc++
{3 Project Explorer X &0 [RZ_T2H_a_as] FSP Configuration

= Outline X =]
= Summary 0 There is no active editor that provides an | &

~ 1S RZ.T2H_a_as Generate Project Content outline.

i Includes N
e Project Summary
configurationxml
RZ.T2H_a_as Debug_Flatjli Board: RZT2H Evaluation Board (RAM execution without flash memory)

e i 5 Device: ROAOSGOTTMAAGBG

X| RZ_T2H_a_as Debug_Flat.a:

Core: CR52 CPUO

Toolchain: GCC for Renesas RZ

Toolchain Version: 12.2 1.am-12-24

FSP Version: 220

Project Type: Flat

Location: C/1_Prog/Work/Work_C/Work_E2S_RZ T2H_Aform_release_chk/RZ_T2H_a_as

~
RENESAS

7) Developer Assistance

Selected software components

Board support package for ROAD9GO77TM44GBG v2.20
Board support package for RZT2H v2.20
Board support package for RZT2H - FSP Data v220 e

QEO

Summary | BSP| Clocks| Pins | Interrupts | Event Links | Stacks| Components

2. Problems > | B Console [Z] Properties | @ Smart Browser [} Smart Manual § =0

0 errors, 12 wamings, 0 others

Description Resource Path Location
& Wamnings (12 items)

Type

7 Select [Project] menu -> [Build All]
The Debug\RZ_T2H_a_as.elf file is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2  Click [Debug] to start downloading to internal RAM.

3  Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/T2H Group A-format Sample Program Application Note.

T COM10 - Tera Term VT - ] X
JPILF)  RE(E (S JIYFO-ILG)  FAUFEW) ALTH)
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RZ/T2H Group
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3.4 Procedures on Development Environments: CA55 ver.

3.4.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select lower-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Order of transmission / reception LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.4.2 EWARM from IAR Systems

(1) Build Environment

IAR Embedded Workbench for ARM (EWARM)

Version 9.60.2 + patch (EWARM_Patch_for RZT2H_ N2H_rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2024-10
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs

The build procedure for the sample program is as follows.

1 Extract RZ_T2H _CA55_a_as.zip and copy the extracted source files to the desired location.

Activate EWARM.

a b wWwN

Select [File] menu -> [Open Workspace].
Open the extracted source file RZ_T2H_CR52_0_primary -> RZ_T2H_CR52_0_primary.eww.
Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS
Argument --compiler IAR configuration.xml

Initial directory

$PROJ_DIRS$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.
You can also start the FSP Smart Configurator directly from the command prompt by specifying the

folder where it is installed.
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RZ/T2H Group
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6

In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

G C¥1_Prog¥Work¥Work C¥Work EWA_960 2 fsp2.2.08RZT2H_Aform CASS.release_chk¥RZ_T2H_CRS2.0 primary - FSP Smart Configurator

- [m] x ‘
File Window Run Help
8} [RZ_T2H_CR52_0_primary] FSP Configuration % FSP Visualization =]
Summary Generate Project Content K = 2
Project Summa ~
: B RENESAS
Board: RZT2H Evaluation Board (RAM execution without flash memory)
Device: ROA09GOTTM44GBG
Core: CR52 CPUD
FSP Version: 22.0
Project Type: Flat
Location: C:/1_Prog/WorkiWork_C/Work_EWA_96__release_chk/RZ_T2H_CRS52_0_primary cj
Selected software components
Board support package for ROA09GO77M44GBG v220
Board support package for RZT2H v220
Board support package for RZT2H - FSP Data v2.2.0 v

020

Summary | BSP| Clocks| P

[ properties [%] Problems 2§ = 0 Bconsole

No consoles to display at this time.

Properties are not available.

When project generation is complete, close the Smart Configurator.
Select [Rebuild ALL] from the [Project] menu of EWARM.

The file Debug\Exe\RZ_T2H_CR52_0_primary.sbd is generated.

9 Select [File] menu -> [Open Workspace].

10 Open the extracted source file RZ T2H CA55 0 a as > RZ T2H CA55 0 _a as.eww.

(RZ_T2H_CR52_0_primary.sbd of the primary project is referenced to open this workspace file.
Please build the primary project in advance.)

11 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE.

12 In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

G C¥1_Prog¥Work¥Work CAWork_EWA_960_2 fsp2.2.04RZT2H_Aform_CASS_release_chk¥RZ_T2H_CASS 0 a_as - FSP Smart Configurator

- [m] x ‘
File Window Run Help
{8} [RZ_T2H_CAS5_0_a_as] FSP Configuration 5 FSP Visualization = a
| g C »

Sumimary Generate Project Content K = -

Project Summai ~

: o RENESAS

Board: RZT2H Evaluation Board (RAM execution without flash memory)

Device: RIADIGOTTMA4GBG

Core: CAS55 Core0

FSP Version: 220
Project Type: Flat

Location: C:/1_Prog/Work/Work_C/Work_EWA_96
Selected software components

Board support package for ROAOSGO77MA4GBG

v220
Board support package for RZT2H v2.20
Board support package for RZT2H - FSP Data V220 %

55_release_chk/RZ_T2H_CA55_0_a_as <~

[2] Properties (2] Problems

8§ =0 Bconsole

No consoles to display at this time.

Properties are not available.

13 When project generation is complete, close the Smart Configurator.
14 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\ RZ_T2H CA55 0 a_as.out is generated.

(4) Sample Program Execution Procedure

R11ANO779EJ0201 Rev.2.01 Page 13 of 18
Dec 13.24

RENESAS



RZ/T2H Group Encoder I/F A-format sample program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Inthe workspace of RZ_T2H_CR52_0_primary, select [Project] menu -> [Download and Debug].
RZ_T2H_CA55 0_a_as project is launched.

2 Inthe workspace of RZ_T2H CR52_0_primary, select [Debug] menu -> [Execute]. CA55 start-up
program is executed.

3 Inthe workspace of RZ_ T2H_CA55 0_a_as, select [Debug] menu -> [Execute]. Sample program is
executed.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/T2H Group A-format Sample Program Application Note.

1 COMS - Tera Term VT - ] >
JrA LR REE) (S JYRO-JL0O)  DAUEDW) ALTH)
rt

3.4.3 e? studio from RENESAS
(1) Build Environment

RENESAS e? studio 2024-10
Toolchain version:
GNU ARM Embedded 12.2.1.arm-12-24 (Used by RZ_T2H_CR52_0_primary.)
GCC ARM A-Profile (Aarch64 bare-metal) 10.3.1.20210621 (Used by RZ T2H_CA55 0_a as.)
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
SEGGER J-Link v7.98c

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_T2H CA55_a_as.zip and copy the extracted source files to the desired location.
2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select
Existing project to workspace and click [Next].
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RZ/T2H Group Encoder I/F A-format sample program

3 On the project import screen, select the folder where the sample program was expanded as the root

directory.
Select a project, check Copy Project to Workspace, and click [Finish].

Double-click the configuration.xml of the RZ_T2H_CR52_0_primary project in the Project Explorer
pane of e? studio to open it.

4
5

ﬁ RZT2H_Aform_CASS_release_chk - &° studio — O * |
File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas Al Window Help

WA o Q- Q | EEcces
ICy Project Explorer % i = 0O ||E= Outline X =2 0a

= § There is no active editor that | &%

v |5 RZ_T2H_CAS5.0 a_as provides an outline.

sl Includes

B src

= configuration.xml

RZ_T2H_CAS5_0_a_as Debug_Flat

X| RZ_T2H_CA55_0_a_as Debug_Flat

?7) Developer Assistance
~ |5 RZ_T2H_CR52_0_primary [Debu

imi Includes

e

5} configuration.xml

RZ_TZH_CR5Z_U_pnmary Debug_| i®) problems x [ Console| [T Properties @ Smart Browser <} Smart Manual A =
X| RZ_T2H_CR52_0_primary Debug_| | errors, 24 wamings, 0 others
2) Developer Assistance Description Resource Path Location Type
B Wamings (24 items)

< >
s configurationxml - RZ_T2H_CR52_0_primary

6 Click Generate Project Content in the FSP Configuration pane of e2 studio.

The rzt, rzt_cfg, rzt_gen, script, .settings folders are generated in the RZ_T2H_CR52_0_primary
project.

) RZT2H_Aform_CASS release chk - RZ T2H_CRs2 0 primary/configuration.xml - ¢ studic - [m] x ‘
File Edit Source Refactor Mavigate Search Project RenesasViews Run RenesasAl Window Help
o4~ it Qv Q s |
{5 Project Explorer X § = O |4 RZ_T2H_CR52 0_primary] FSP Configuration X e | O Outline > = 0lg
~ g5 RZ_T2H_CAS5. 0 a_as Thes 45
= RZ_T2H_CAS5.0.a re is o active editor that provides | €
@) Includes Summary Generate Project Content an outline.
B src i
& configurationmi Project Summary AENESAS A
RZ_T2H_CAS5_0_a_as Debug_Flatjlink
% RZ.T2H CAS5.0_a as Debug Flatlaunch Board: RZT2H Evaluation Board (RAM execution without flash memory)
Device: ROADIGO7TMA4GBG
7) Developer Assistance
v 5 RZ_T2H_CR52.0_primary [D: S CR52 GPUO
Toolchain: GCC for Renesas RZ
)l Includes e ienin
& src Version: 1221 arm-12-24
£ configurationmi FSP Version: 220
RZ_T2H_CR52_0_primary Debug_Flatjlink Project Type:  Flat
X| RZ_T2H_CR52_0_primary Debug_Flatiaunch Location: C:11_Prog/Work/Work_C/Work_E2S_RZ...release_chk/RZ_T2H_CRS2_0_primary |
(%) Developer Assistance
Selected software components
Board support package for ROAD9GO7TTM44GBG V220
Board support package for RZT2H v220
Board support package for RZT2H - FSP Data V220 b
jo8 (-
Support _
Summary | BSP| Clacks Pins| Interrupts | Event Links| Stacks Components
. Problems x | B Console [T Properties| @ Smart Browser | () Smart Manual § =0
0 errors, 24 wamings, 0 others
Description Resource Path Location Type
& Wamings (24 items)
%} configurationxml - RZ T2H_CR52 0 primary

7 Select RZ_T2H_CR52_primary project in the Project Explorer pane and execute [Run] menu -> [Build
Project].
The file Debug\RZ_T2H_CR52_0_ primary.sbd is generated.

8 Double-click the configuration.xml of the RZ_T2H_CA55 0 _a_as project in the Project Explorer pane

of e? studio to open it. (RZ_T2H_CR52_0_primary.sbd of the primary project is referenced to open this
configuration file. Please build the primary project in advance.)
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9 Click Generate Project Content in the FSP Configuration pane of e2 studio.
The rzt, rzt_cfg, rzt_gen, script, .settings folders are generated in the RZ_T2H_CA55 0_a_as project.

10 Select [Project] menu -> [Build All]

The Debug\RZ_T2H_CA55_0_a_as.elf file is generated.

(4)

Execution Procedure of the Sample Program

Q RZT2H_Aform_CASS release_chk - RZ_T2H_CAS5 0 a as/configuration.xml - e studio - [m] X ‘
File Edit Source Refactor Navigate Search Project RenesasViews Run RenesasAl Window Help
-8~ witpr Qv Q E| Gk
I¢y Project Explorer < =k § = O |{8 [RZ_T2H_CR52 0_primary] FSP Configuration | [RZ_T2H_CASS_0_a_as] FSP C ninlen 0= Outline X = 0|s
< T ()
~ % RZ_T2H_CAS55 0 a_as There is no active editor that provides | €
Summar P
B Includes Y Generate Project Content Il an outline.
@ src -
{2} configurationxmi Project Summary RENESAS @
RZ_T2H_CAS5_0_a_as Debug_Flatjlink ]
%) RZ_T2H_.CASS_0_a_as Debug_Flatlaunch Board: RZT2H Evaluation Board (RAM execution without flash memory)
Device: ROADIGO77TM44GBG
?) Developer Assistance AS5
v |65 RZ_T2H_CR52_0_primary Core: G ors0
i Toolchain: GCC for Renesas RZ (A-Profile AArchB4 bare-metal)
o
Toolchain
o Includes Version: 10.3.1.20210621
i FSP Version: 220
& rztgen Project Type: Flat
(B st Location: C:M_Prog/Work/Work_C/Work_E2S_RZ..55_release_chk/RZ_T2H_CAS5_0_a_as &=
(= Debug
&t cfg Selected software components
= script
configurationzmi Board support package for RSADSGOTTM44GBG v220
RZ_T2H_CR52_0_primary Debug_Flatjlink Board support package for RZT2H V220 o
%) RZ.T2H_CRS2.0_primary Debug Flatiaunch Board support package for RZT2H - FSP Data V220
7) Developer Assistance —
jol (-
Support -
Summary | BSP| Clocks Pins| Interrupts | Event Links Stacks| Components.
#) Problems [ Console X | [T] Properties @ Smart Browser L} Smart Manual b4 | L BB e mB~8-=0
CDT Build Console [RZ_T2H_CAS5_0_a_as]

After executing the "build procedure”, connect the target board and debugger correctly, and perform the

following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the

RZ T2H CR52_0_primary project.

Click [Debug] to start downloading to internal RAM.
2 Click [Run] menu -> [Resume] to run the CA55 start-up program.
3 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the

RZ_T2H_CA55_0_a_as project.

4 Select 'No' when the dialog box inquiring about termination of the active debug session is displayed.

a Launcher

l A Renesas GDB debug session is already active.

[[]Remember my decision

Yes

5

——

If 'Proceed with launch' is displayed, select 'Yes'.

6 Click [Debug] to start downloading to internal RAM.
7 Click [Run] menu -> [Resume] to run the sample program.

X

Do you want to terminate all currently active debug sessions before starting the new
session? (Note: Selecting No may result in unstable debug functionality)

Cancel
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RZ/T2H Group Encoder I/F A-format sample program

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.8 console commands in the RZ/T2H Group A-format Sample Program Application Note.

1 COMS - Tera Term VT - ul X
TrAL(F) E|EE) E(S)  IVRO-I0)  uERW)  ALTH)
tart
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RZ/T2H Group Encoder I/F A-format sample program

Revision History

Description
Rev. Date Page Summary
0.50 Aug.31.23 - First Edition issued.
0.60 Oct 13.23 2,3 Updated the source code and the release note version
number.
Source code is corrected for preventing command parameter
mismatch.
4 Updated memory size information.
0.70 Mar 29.24 2-3, Updated the source code and the release note version
number.

Update file structure.

Added explanation of CA55 ver.

4, Updated memory size information.
Update build environment.

Added explanation of CA55 ver.

8-11, Update build and execution procedure.
11-17 Execution Procedure

2.00 Nov 21.24 2-4 Updated revisions of the application note and the release
note.

Updated sample program version to 2.0. (Supported FSP
v2.2.0.)

Updated the file structure.

5 Updated memory size information.

Add SW14-6 in setting of target board.

8-17 Updated build environment for FSP v2.2.0. Figures are
replaced.

2.01 Dec 13.24 2,3 Update revision of the release note.
Correct path name of the FSP SC in the sample program
environment files to use default installation path.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.

Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products

outside of such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2024 Renesas Electronics Corporation. All rights reserved.
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